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1 Front Matter
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About the Integration
The Telelogic® Synergy™ for Microsoft® Visual Studio Interface™ gives you change management (CM) 
support through insulated and build management work areas, provides task-based CM support, and 
supports source code control operations on project files directly from Microsoft Visual Studio 2005.  This 
integration lets you control and set up your Visual Studio 2005 projects in Telelogic Synergy.  This 
integration is provided in the form of an install program which can be downloaded from Telelogic's 
website.

Assumptions
Before using this document, you should have a basic understanding of how to use the Microsoft Visual 
Studio 2005 IDE and Telelogic Synergy.  If you are unfamiliar with Visual Studio 2005, Telelogic 
recommends that you go through a tutorial and online help for Visual Studio 2005.

 For information on Microsoft Visual Studio 2005:  refer to the MSDN Library for Visual Studio 
2005.

You should also have a conceptual and practical understanding of Telelogic Synergy.  You should 
understand task-based CM and be able to perform developer or build manager operations.

 For information about Telelogic Synergy:  refer to the following documentation, which is 
available on the Telelogic Synergy documentation website: 
http://support.telelogic.com/synergy/

 For terms, concepts, and methodology:  refer to the Introduction to Telelogic Synergy

 For information about build management-level operations:  refer to the Build Manager's 
Guide.

 For a description of Telelogic Synergy dialog boxes, commands, and default settings:  
refer to the Telelogic Synergy Help.

Telelogic recommends that you read this entire document before using the integration.  Knowing all of the 
features before you integrate your data will help ensure a seamless, efficient integration.

Features
This integration lets you use the source code control and task-based CM operations from the Visual Studio 
2005 development IDE.  You can configure the integration to use multiple Telelogic Synergy databases.

How the Integration Works
This integration has been completely rewritten for Microsoft Visual Studio 2005; therefore, it has 
significant changes from the previous Microsoft Visual Studio 2003 integration (version 2.3).

The integration can connect to multiple Telelogic Synergy databases using Telelogic 
Synergy Connections.  A Telelogic Synergy Connection uniquely represents a Telelogic 
Synergy database.  When you start a Telelogic Synergy Connection, a corresponding Telelogic 
Synergy session is started.  A Telelogic Synergy Connection is required by the integration to be able to 
connect to the Telelogic Synergy database.

You will need to customize your Microsoft Visual Studio 2005 IDE to see the Telelogic Synergy Task
menu and Telelogic Synergy Task toolbar.  You will also need to open the Telelogic Synergy output 
Console Window to view the messages returned by the integration.

 Audience
The audience for this document is developers.  The information in the Telelogic Synergy for Microsoft 
Visual Studio Interface Help assumes that you have a basic understanding of how to use Microsoft Visual 
Studio 2005 and the Telelogic Synergy client.  Information about Telelogic Synergy in this document is 
limited to what is essential for you to know to use the integration.

Notices (Section 13)

 

2 Introduction
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Telelogic Synergy for Microsoft Visual Studio Interface offers the following new features:

 This integration is based on Visual Studio Industry Partners program. It is written as a Visual 
Studio Package. 

 This version of the integration will only work with Telelogic Synergy 7.0.  Telelogic 
Synergy Classic client or older versions of Telelogic Synergy are not supported by this integration. 

 This version of the integration will only work with Microsoft Visual Studio 2005.  However, it can 
co-exist with the Visual Studio 2003 Integration, Release 2.4 and Telelogic Synergy for Microsoft 
Visual Studio Interface, Release 4.1. 

 The integration name has been changed from Telelogic Synergy and Microsoft Visual Studio 2005 
Integration to Telelogic Synergy for Microsoft Visual Studio Interface. 

 

3 What is New
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The following products are required to run Telelogic Synergy for Microsoft Visual Studio Interface:

 Microsoft® Windows Vista® or XP 

 Microsoft Visual Studio 2005 

 Telelogic Synergy 7.0 on Windows Vista or XP 

 Telelogic® Change™ 5.1 (Optional) 

 

4 Product Requirements
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Before you install the integration, Telelogic Synergy Release 7.0 and Microsoft Visual Studio 2005 must
be installed.  The information below will provide some instructions on how to install Telelogic Synergy.

Install Telelogic Synergy
Refer to the installation instructions for Telelogic Synergy in the Telelogic Synergy Installation Guide for 
Windows.

 

After you have properly installed Telelogic Synergy and Microsoft Visual Studio 2005, you are ready to 
install Telelogic Synergy for Microsoft Visual Studio Interface.  To learn how to install the integration, 
see Install the Integration (Section 5.1).

Note Before you install Telelogic Synergy for Microsoft Visual Studio Interface, please make sure that you 
have done the following:

 Install Telelogic Synergy Release 7.0 and Microsoft Visual Studio 2005. 

 Uninstall any previous versions of Telelogic Synergy for Microsoft Visual Studio Interface. 

 Uninstall any previous versions of Telelogic Synergy for Microsoft Visual Studio Interface Help.  To 
do this, go to Control Panel > Add or remove Programs and remove the Telelogic Synergy 
for Microsoft Visual Studio Interface Help program. 

 Stop all Telelogic Synergy sessions. 

 Read the Team Development and Source Control Operation documentation provided by Microsoft. 

 Set your Telelogic Synergy database(s) to case=PRESERVE. 

Please carefully follow the steps below to install Telelogic Synergy for Microsoft Visual Studio Interface:

1.  Download Telelogic Synergy for Microsoft Visual Studio Interface 3.4 from the Telelogic Synergy 
Integrations web site at: http://support.telelogic.com/synergy/

2.  The integration is in a zip file named VS2005int_34.ZIP. Unzip the zip file to a temporary 
directory.  Navigate to setup.exe and run the setup.  The setup wizard will guide you through the 
installation steps.

3.  After installing the integration, start Microsoft Visual Studio 2005.

 

5 Installation Instructions

5.1 Install the Integration
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After you have successfully installed the integration, you will need to perform additional set-up and 
installation activities before you can begin using the integration.  You will need to customize Microsoft 
Visual Studio 2005 to view the Telelogic Synergy toolbar and menu as well as other views offered by the 
integration.

Note It is important that you read the latest Readme to view the most current information.

 Setting Up the Database (Section 6.1)

 Setting Up the Work Area (Section 6.2)

 Install Visual Studio File Types and Ignore Rules (Section 6.3)

 Select the Source Control Plug-In (Section 6.4)

 Activate the Telelogic Synergy Taskbar (Section 6.5)

 Activate the Telelogic Synergy Output Console Window (Section 6.6)

 Activate the Telelogic Synergy Task View (Section 6.7)

 Activate the Telelogic Synergy Change Request View (Section 6.8)

Before you can properly begin using the integration, it is important that you set up your Telelogic Synergy 
database.  There are two important set-up activities to perform on your Telelogic Synergy database.

1. Make sure that your Telelogic Synergy database is set to Preserve case.  Follow the steps below to 
accomplish this. 

1. Open up a command prompt on the Telelogic Synergy server machine and ensure that ccmdb is in 
your path.

2. Type the following command: ccmdb info <dbpath> /k case /v PRESERVE

3. Exit the command prompt. 

4. Restart the machine. 

2. Make sure that your Telelogic Synergy database is set to support multiple project instances.  This is 
required to support the creation of Solution projects having the same name as the Solution.  Follow 
the steps below to accomplish this. 

1. Start a Telelogic Synergy session using the Telelogic Synergy Classic Client. 

2. Open up a command prompt on the Telelogic Synergy server machine and ensure that ccm is in 
your path.

3. Type the following commands: 

 ccm set role ccm_admin

 ccm query -t model -n base

 ccm attr -m multiple_local_proj_instances -v TRUE @1

4. Exit the command prompt. 

Before you begin using the integration to perform source code control operations, you must set Telelogic 
Synergy to use a work area template that does not contain project or database specific information.  
Please follow the steps provided below to properly set your work area template.

1.  Start a Telelogic Synergy session.

2.  Click Tools and select Options.  The Options dialog box will appear as shown below.

6 Before Using the Integration

6.1 Setting Up the Database

6.2 Setting Up the Work Area
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Figure 1. Options dialog box

3.  Click the Actions tab and select Copy Project from the list provided.  The Options dialog box will 
now appear similar to Figure 2 below.
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Figure 2. Options dialog box

4.  Make sure that the + Database name and the Add project-specific directory options are not selected.

5.  Click Apply to save your changes, then click OK to exit the Options dialog box.

Note You need this work area template only for project migration. It is not required to have this work 
area template for the Copy Project operation.

Microsoft Visual Studio file types and ignore rules must be installed into each Telelogic Synergy database 
before you can use the integration.  To install these types, your group membership must include 
ccm_admin privileges.

1.  Start a Telelogic Synergy session using the Telelogic Synergy Classic Client.

2.  Set your role to ccm_admin.

3.  Load the Visual Studio file types by running the Telelogic Synergy for Microsoft Visual Studio Interface 
Install File Types program.  This program will install different file types for Microsoft Visual Studio 2005.  
Please follow the steps below:

1. Find the Microsoft Visual Studio 2005 Install File Types program, which is located in the following 
location: Start > All Programs > Telelogic > Integrations > Telelogic Synergy for 
Microsoft Visual Studio Interface 3.4

2. Click the Install Visual Studio file types option and follow the instructions. 

6.3 Install Visual Studio File Types and Ignore Rules
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4.  After the installation is complete, exit and restart your Telelogic Synergy session.

Before you can use any of the task-based and source code control operations that Telelogic Synergy for 
Microsoft Visual Studio Interface offers, you must first select Telelogic Synergy as your source control 
plug-in selection.  Follow the steps below.

1.  Open the Microsoft Visual Studio 2005 IDE.

2.  In the Microsoft Visual Studio 2005 main menu, click Tools, then select Options.

3.  The Options dialog box will appear as shown below.

Figure 3. Options dialog box

4.  Select Source Control, then select the Plug-in Selection option.  The Options dialog box will 
look similar to what is displayed below and will allow you to choose your current source control plug-
in.  You must select Telelogic Synergy.

6.4 Select the Source Control Plug-In
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Figure 4. Options dialog box Plug-In Selection

5.  After you have selected Telelogic Synergy, click OK.

Note  Once you have selected Telelogic Synergy as your current source control plug-in, the Telelogic 
Synergy Settings dialog box may appear if you have no Telelogic Synergy connections available.  You 
must create a Telelogic Synergy connection in order to perform the source control operations offered 
by the integration.  Please refer to the Connection Management (Section 9.5.1) section to learn 
how to create a connection.

In order to use the Telelogic Synergy Taskbar that is made available to you by the integration, you must 
first activate it.  Follow the steps below.

1.  In the Microsoft Visual Studio 2005 IDE, click Tools, then select Customize.

2.  The Customize dialog box will appear as shown below.

6.5 Activate the Telelogic Synergy Taskbar
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Figure 5. Customize dialog box

3.  Select the Telelogic Synergy Taskbar option, then Close.

Figure 6. Customize dialog box selecting Telelogic Synergy Taskbar

There is another way to activate the Telelogic Synergy Taskbar.  The steps below will explain an 
alternative way to activate the Telelogic Synergy Taskbar.
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1.  In the Microsoft Visual Studio IDE, right click on any available space around the toolbars.  You will 
see several menu options similar to the ones displayed below.

Figure 7. Toolbar Menu options

2.  Select Telelogic Synergy Taskbar.  The Telelogic Synergy Taskbar (see Figure 8) will now be 
available as an additional toolbar in the Microsoft Visual Studio IDE.

Figure 8.  Telelogic Synergy Taskbar

In order to view any messages that result from performing any of the version control operations, you 

6.6 Activate the Telelogic Synergy Output Console Window
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must activate the Telelogic Synergy Output console window.  Follow the steps below.

  In the Microsoft Visual Studio 2005 IDE, click View, then select Output. 

The Output console window will appear at the bottom of the Microsoft Visual Studio 2005 IDE.  You 
will now be able to view the messages that result from any source control operations that you 
perform.

Figure 9. Telelogic Synergy Output Console Window

The Telelogic Synergy Task View will be activated automatically and added to the Microsoft Visual 
Studio 2005 IDE once you select Telelogic Synergy as your source control plug-in.  Please refer to Select 
the Source Control Plug-In (Section 6.4) section for more information on how to select 
Telelogic Synergy as your source control plug-in.

6.7 Activate the Telelogic Synergy Task View
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Figure 9.1. Telelogic Synergy Task View

If you want to close the Telelogic Synergy Task View while you are using the integration, simply close 
the view just as you would if you were closing any of Microsoft Visual Studio's views/windows.

To activate the Telelogic Synergy Task View again, follow the steps below.

 In the Microsoft Visual Studio 2005 main menu, click on View > Telelogic Synergy, then 
select Telelogic Synergy Task View. 

Figure 9.1.1. Telelogic Synergy Task View Menu

The Telelogic Synergy Task View will again be added to the Microsoft Visual Studio IDE.

Note The Telelogic Synergy Task View will automatically be removed from the Microsoft Visual 
Studio 2005 IDE once you disable Telelogic Synergy as your source control plug-in selection.    
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The Telelogic Synergy Change Request View will be activated automatically and added to the 
Microsoft Visual Studio IDE once you select Telelogic Synergy as your source control plug-in.  Please refer 
to Select the Source Control Plug-In (Section 6.4) section for more information on how to select 
Telelogic Synergy as your source control plug-in.

Figure 9.2. Telelogic Synergy Change Request View

If you want to close the Telelogic Synergy Change Request View while you are using the integration, 
simply close the view just as you would if you were closing any of Microsoft Visual Studio's 
views/windows.

To activate the Telelogic Synergy Change Request View again, follow the steps below.

 In the Microsoft Visual Studio 2005 main menu, click on View > Telelogic Synergy, then 
select Telelogic Synergy Change Request View. 

6.8 Activate the Telelogic Synergy Change Request View
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Figure 9.2.1. Telelogic Synergy Change Request View Menu

The Telelogic Synergy Change Request View will again be added to the Microsoft Visual Studio 
IDE.

Note The Telelogic Synergy Change Request View will automatically be removed from the 
Microsoft Visual Studio 2005 IDE once you disable Telelogic Synergy as your source control plug-in 
selection.     
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Project setup and data migration is the process of starting a project in Microsoft Visual Studio 2005 and 
controlling the same project under Telelogic Synergy configuration management.  The following sections 
will describe this process.

 Project Mapping (Section 7.1)

 How to Migrate (Section 7.2)

 Migrate using Migrate Tools (Section 7.2.1)

 Migrate from within Microsoft Visual Studio (Section 7.2.2)

 Rebuild and Baseline Your Project (Section 7.2.3)

A Visual Studio Solution consists of many projects.  These projects may be located anywhere in the file 
system.  Project mapping is the process of defining how a Visual Studio project corresponds to a project 
in Telelogic Synergy.  This integration maps a Visual Studio Solution and its projects to Telelogic Synergy 
projects according to the following rules.

1.  A Solution is mapped to a project in Telelogic Synergy with an absolute work area.  In Telelogic 
Synergy, the Solution will be the top-level project.

2.  A project that is located inside the Solution directory in the file system may be migrated as a 
project or a directory in Telelogic Synergy.

 If a project is migrated as a project, it must have a relative work area and will be defined as a 
subproject of the Solution project (top-level project) in Telelogic Synergy. 

 If a project is migrated as a directory, it must have a relative work area and will be defined as 
a directory of the Solution project (top-level project) in Telelogic Synergy. 

3.  A project that is located outside the Solution directory in the file system may only be migrated as 
a project.  These types of projects must have an absolute work area and will be defined as a 
subproject of the Solution project (top-level project) in Telelogic Synergy.

Other Recommendations:

If the option Show Miscellaneous Files in Solution Explorer is enabled in Tools > Options > 
Environment > Documents, the files that are placed in the Miscellaneous Files folder will not be 
migrated to Telelogic Synergy when the Solution or Project is migrated.  Also, you will not be able to 
migrate the Miscellaneous Files folder and all its files to Telelogic Synergy separately.  (To learn more 
about the Miscellaneous Files folder, go to Microsoft Help)

If you feel that the files contained in the Miscellaneous Files folder are important and you would like to 
control the files under Telelogic Synergy, you may do one of the following:

 Create a Solution folder and place the files in the Solution folder.  Files contained in a Solution 
folder will be migrated to Telelogic Synergy when the Solution is migrated.  

 Create a Project folder and place the files in the Project folder.  Files contained in a Project folder 
will be migrated to Telelogic Synergy when the Solution or Project is migrated. 

Note  You may also migrate files in a Solution or Project folder by performing the Add Uncontrolled 
Files operation (To read more about the Add Uncontrolled Files  operation, go to How to add new 
files and folders to database (Section 10.4)). 

Note  In order for your Solutions/Projects to work effectively in a team environment, it is important that 
they are structured properly.  When you structure your Solutions and Projects, make sure that your 
Solutions and Projects have a relative work area. 

You can accomplish this in two ways. 

 When creating your Solutions and Projects, make sure that all of the Projects contained in 
your Solutions have a relative work area instead of an absolute work area 

 Modify your Solution files so that the Project paths are relative rather than absolute. 

Build your Application in Visual Studio

7 Project Setup and Migration

7.1 Project Mapping

7.2 How to Migrate
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Before you can migrate Solutions and Projects to Telelogic Synergy, you must first prepare and build your 
Solutions and Projects in Visual Studio.  Ensure that you have done the following before you migrate your 
projects to Telelogic Synergy.

1.  Prepare the Solutions and Projects that you want to migrate to Telelogic Synergy 
by creating/opening the Solutions and Projects in Visual Studio.

2.  Make sure that the application builds properly in Visual Studio and that all the files/folders that you 
want to control under Telelogic Synergy are in your work area.

Your project is now ready for migration.

Migrate to Telelogic Synergy
Caution  Before you migrate your Solutions/Projects to Telelogic Synergy, make sure that you have 
installed the Microsoft Visual Studio file types into your Telelogic Synergy database.  To read more about 
how you can install the Microsoft Visual Studio file types into your Telelogic Synergy database, refer to 
the Install Visual Studio File Types and Ignore Rules (Section 6.3) section.

There are two ways to migrate projects to Telelogic Synergy, one from Telelogic Synergy directly, and the 
other from the Microsoft Visual Studio IDE by using the integration.  Both process are described below:

 Migrate using Migrate Tools (Section 7.2.1)

 Migrate from within Microsoft Visual Studio (Section 7.2.2)

Rebuild and Baseline your Project
Once you have properly migrated your Solutions and Projects to Telelogic Synergy, you must now rebuild 
and baseline your projects.  The following section will explain the process of baselining the projects that 
you migrated to Telelogic Synergy.

 Rebuild and Baseline Your Project (Section 7.2.3)

Refer to Telelogic Synergy Classic Client help for project migration.

Notes 

 If you use Telelogic Synergy Classic Client to migrate a Solution/Project, it is your responsibility to 
specify the files that you want to ignore during migration.  For example, *.suo and *.user files 
should be ignored when migrating Solutions/Projects.  

 If you are migrating Projects using the Telelogic Synergy Classic Client, you must follow the steps 
provided below. 

1. Exit Microsoft Visual Studio IDE. 

2. Make sure that you have installed all Microsoft Visual Studio File Types and Ignore Rules. 

3. Migrate the Solution project first.  All Projects located inside the Solution directory will be 
migrated only as directories. 

4. Migrate all the Projects located outside the Solution directory separately (one at a time). 

5. After you have migrated the Solution and all of the Projects, you may associate all of the outside 
Projects to the Solution project by adding all of the outside Projects as subprojects to the Solution 
project using Telelogic Synergy Classic Client.  

6. Edit the *.sln file in order to ensure that the references to all of the Projects are still correct.

7. If the Solution contained Web Projects, you may need to modify the Virtual Directory properties 
(located within Internet Information Services) to ensure that the Local Path points to the 
current location.  

8. Open Microsoft Visual Studio IDE and open the Solution from the new work area location.  

The following information will explain the process of migrating Solutions and Projects from within the 
Microsoft Visual Studio IDE by using the integration.

Notes

 Before you migrate your Solutions/Projects to Telelogic Synergy, make sure that all of the project 
path/files are not locked.  The integration needs to move/rename the project files during the process 
of migration and if any of the project path/files are locked, the integration will not be able to migrate 

7.2.1 Migrate using Migrate Tools

7.2.2 Migrate from within Microsoft Visual Studio
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the Solutions/Projects properly. 

 

 If your Solution contains a project which has the same name as the Solution, make sure that your 
Telelogic Synergy database is set to support multiple project instances.  If you decide not to set your 
Telelogic Synergy database to support multiple project instances, you must do one of the following in 
order for the project migration to work properly. 

 Rename the Solution.  In order to rename the Solution properly, you must rename the following: 

 .sln file 

 the directory containing the .sln file 

 Rename the Project.  In order to rename the Project properly, you must rename the following: 

 project file 

 the directory containing the project file 

Caution When you rename the directory containing the project file, you must also update the 
Solution file so that it will still point to the renamed project.

In order for the integration to perform the migration, you must have a defined connection to a Telelogic 
Synergy database to which you want to migrate the project.  Refer to the Connection Management 
(Section 9.5.1) section to learn how to create a connection.

Carefully follow the steps below to migrate your Solutions and Projects to Telelogic Synergy.

1.  Ensure that you have a Telelogic Synergy connection.

2.  Right click the Solution in the Solution Explorer.  Select the Telelogic Synergy option, then select 
Create Project in Telelogic Synergy, or in the Microsoft Visual Studio 2005 main menu, click on 
File > Telelogic Synergy, then select Create Project in Telelogic Synergy.

3.  The Create Project in Telelogic Synergy dialog box will appear as shown below.
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Figure 10. Create Project in Telelogic Synergy dialog box

Notes 

 Make sure to specify whether you want the projects created as a project or as a directory.  
Remember that projects located outside the Solution directory in the file system may only be 
migrated as a project, and projects located inside the Solution directory in the file system 
may be migrated as a project or a directory. 

 Remember ASP.Net Web Application projects whose location in the file system is inside the 
directory of another Project or Solution directory may only be migrated to Telelogic Synergy 
as a directory when using the integration.    

4.  By using the Create Project in Telelogic Synergy dialog box, you can choose not to migrate 
some of the projects in your Solution. 

Caution  If you choose not to migrate the Solution, you will not be allowed to migrate any of the 
projects that are located inside the Solution directory in the file system.  The only way to migrate 
projects located inside the Solution directory is by also choosing to migrate the Solution.

5.  Select the appropriate Connection Name, Release, Purpose, Platform, Default Task, and 
write an appropriate Description.

6.  Click Create.  You will see a progress dialog box.
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Figure 11a. Create Projects Progress dialog box

Note  If the database currently selected for project migration is not set to PRESERVE case, the 
integration will warn users before migrating the Solutions/Projects.

7.  When project creation is finished, Microsoft Visual Studio will display a warning dialog box stating 
that the Solution has been modified outside the environment (see Figure 11b).  Before you respond to 
the Conflicting File Modification Detected (Figure 11b) dialog box, make sure that the progress 
dialog box (see Figure 11a) above has disappeared.

Figure 11b. Conflicting File Modification Detected dialog box

8.  Click Overwrite.  Microsoft Visual Studio will prompt you to save the Solutions by displaying the 
dialog box shown below.  You must click Yes to save the current state of your Solutions and Projects.

Figure 12.  Save Solutions Prompt dialog box

9.  The Solutions and Projects files are now properly decorated in the Solution Explorer.
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Figure 13.  Solution Explorer containing the decorated Solutions and Projects files

Note  Web projects will not display glyphs even if they are controlled.

10.  Click on File > Save All in the Microsoft Visual Studio 2005 main menu. 

Your Solutions and Projects are now controlled under Telelogic Synergy.

Your Solutions and Projects are now in Telelogic Synergy.  Perform the following steps to baseline the 
Projects.

Telelogic recommends that you rename the directory containing the Solution in the file system.  This 
allows you to check if all the necessary files have been migrated when the Solution is re-built after 
performing the Open Project operation.

1.  Open the Microsoft Visual Studio IDE.

2.  Open the projects that you just migrated to Telelogic Synergy by using the integration.  You may 
do this by clicking on the Open Project button located in the Telelogic Synergy Taskbar (see figure 
14) or by selecting the option Open Project from the Telelogic Synergy menu (see figure 15).

Figure 14. Telelogic Synergy Taskbar Open Project Option

7.2.3 Rebuild and Baseline Your Project

 

Telelogic Synergy for Microsoft Visual Studio Interface 3.4 | 22



Figure 15. Telelogic Synergy menu Open Project Option

3.  The Open Telelogic Synergy Project dialog box will appear similar to the one displayed below.  
It will display all the working projects, including prep projects.  The Open Telelogic Synergy 
Project dialog box will also display the available project versions for each project.

Figure 16. Open Telelogic Synergy Project dialog box

4.  Select the appropriate project and version that you want to open.

5.  Click Open.  When you open a project,

 The project and version that you selected will be opened as a Visual Studio 
Solution/Project in the Microsoft Visual Studio 2005 IDE.

 The Solution and Project files will be displayed in the Solution Explorer with appropriate 
decorators that indicate their current source control status.

6.  Rebuild the Solutions and/or Projects that you just opened.

7.  To baseline the Projects, you may be required to use the Telelogic Synergy Classic Client.  You 

Telelogic Synergy for Microsoft Visual Studio Interface 3.4 | 23



must have the build_mgr or ccm_admin role. 

 If you don't have either role, make sure all the tasks are checked in and that no files in 
your Telelogic Synergy project are checked out.  Now you can ask your build manager or 
administrator to baseline your project.  Baseline projects are in a non-modifiable state, 
such as released, integrate, etc.

Note  For additional information on project baselines, refer to the Telelogic Synergy documentation.
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Once you have baselined your projects, delete your work area.  Your work area will not be valid 
anymore.  You should now copy the project and open that project in Microsoft Visual Studio to carry on 
with the development process.  When you copy the project, you will get a new working copy of the 
project.  It is important that you have a working copy of the project in order to make any changes.

In order to get a working copy of a project, you must perform the Copy Project operation.

 Copy a Project (Section 8.1)

After you have successfully copied the project, you may open the project by using one of the options 
listed below.

 Open Project from Telelogic Synergy Taskbar (Section 9.1.5)

 Open a Project from the File System (Section 8.2)

 Open Visual Studio .NET 2003 Projects (Section 8.3)

Before you can continue on with the development process, you must first get a new working copy of the 
project.  You can do this by using the Copy Project operation provided to you by the integration.  The 
following information will explain the process of copying a project.

Notes

 The Copy Project operation requires that the .sln file and all project files be non-modifiable 
(integrate state).  After executing the Copy Project operation, you may be prompted by the 
integration to check out the .sln file and all project files, always select Yes.

 Before performing the Copy Project operation, make sure that the new work area location is 
empty.

 Telelogic recommends that when copying projects, make sure your work area template includes 
project specific information that includes the project version and project instance.

1.  Open the Microsoft Visual Studio IDE.

2.  Copy the project that you have controlled under Telelogic Synergy.  You may do this by clicking 
Copy Project located in the Telelogic Synergy Taskbar (see figure 17) or by selecting Copy Project
from the Telelogic Synergy menu (see figure 18).

Figure 17. Telelogic Synergy Taskbar Copy Project Option

Figure 18. Telelogic Synergy menu Copy Project Option

8 Setting Up a Development Project

8.1 Copy a Project
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3.  The Copy Telelogic Synergy Project dialog box will appear as shown below.  The value in the 
New Version box will be the next version recommended by the integration.  The Copy Telelogic 
Synergy Project dialog box will display all of the available projects and project versions.

Figure 19. Copy Telelogic Synergy Project dialog box

4.  Select the project and project version that you want to copy.  Also, make sure that the appropriate 
Connection Name, Current Task, Scope, New Version, Release, Purpose, and Work Area for 
the project that you are copying are set properly.  If you need further help understanding and setting 
the available options, go to the Telelogic Synergy Help to read more about copying projects.

5.  Copy the project by clicking Copy.  The project and project version that you selected will be 
copied and added to the Solution Explorer.

Note  If you want to also copy the subprojects, make sure to select the checkbox next to the 
Also Copy Subprojects option.

If you have a working project and you know its location in the file system, you can also open the project 
by using the Microsoft Visual Studio IDE's Open Project/Solution menu.

Follow the steps below.

1.  Open the Microsoft Visual Studio 2005 IDE.

2.  On Visual Studio's main menu, click File > Open , then select Project/Solution.

3.  Locate the Project/Solution that you want to open and then open it.  Microsoft Visual Studio will 
now open the Project/Solution that you selected.  The Project/Solution will be added to the Solution 
Explorer.

4.  To connect the Project/Solution to Telelogic Synergy, select the Solution or Project in the Solution 

8.2 Open a Project from the File System
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Explorer, then select the Connect option from the Telelogic Synergy menu.  The integration will 
display the Select Connection dialog box.  This dialog box will allow you to select a connection.

Note  If you connect the Solution, the Solution and all the Projects contained in the Solution will be 
connected to Telelogic Synergy.  If you connect only the Project, just the Project that you selected will 
be connected to Telelogic Synergy.

Figure 20. Select Connection dialog box

5.  Select the appropriate connection by highlighting it, then clicking Select. 

 The Project/Solution that you opened will now be connected to Telelogic Synergy.  

6.  Once you are connected, save all the files by clicking File > Save All in the Microsoft Visual Studio 
IDE's main menu.  The next time you open this Project/Solution, the Project/Solution will open up as 
connected.

 

 

8.3 Open Visual Studio .NET 2003 Projects
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This section outlines some of the new options and features that are provided in the integration.

9 Getting Familiar with the Integration
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Telelogic recommends that you read the following sections in order to use the integration to its full 
potential.

 Telelogic Synergy Taskbar (Section 9.1)

 Telelogic Synergy Output Console Window (Section 9.2)

 Telelogic Synergy Task View (Section 9.3.1)

 Telelogic Synergy Change Request View (Section 9.3.2)

 Symbols and Tooltips (Section 9.4)

 Settings (Section 9.5)

 Telelogic Synergy 'smart-card' login feature (Telelogic Synergy 'smart-card' login 
feature.html)

9.1 Telelogic Synergy Taskbar
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The Telelogic Synergy Taskbar and menu offer a quick way to perform task, project, and settings 
operations.

Figure 21.  Telelogic Synergy Taskbar and Menu

These operations are further described in the following sections.

Use the Create Task menu option or click the  Create Task icon to bring up the Create Task dialog 
box.

9.1.1 Create a Task
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     Figure 22.  Create Task dialog box

Fill in all of the available options (Task Synopsis, Resolver, Release, Priority, Platform, Subsystem , 
Estimated Effort, Estimated Date, and Description), then click Create to create a new task.  The 
newly created task will become your current task.

Use the Complete Task menu option or click the  Complete Task icon to bring up the Complete 
Task dialog box.

When the Complete Task dialog box appears, the current task will automatically be selected.

9.1.2 Complete a Task
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         Figure 23.  Complete Task dialog box

1.  Select the task that you want to complete.

2.  Select or fill in the following options (Connection Name, Actual Effort, and Description), then click 
Complete to complete the selected task.

Note  You must refresh the status of your Solution in order to see the updated version control status 
symbols.  Refer to How to Refresh the Version Control Status (Section 10.15).

Use the Show Task menu option or click the  Show Task icon to bring up the Task Properties dialog 
box.

9.1.3 Show Task Properties
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      Figure 24. Task Properties dialog box

You can view and/or make any changes to the task properties.  When you are done, click OK  to save the 
changes to the task properties.

Use the Select Task menu option or click the  Select Task icon to bring up the Telelogic 
Synergy Select Task dialog box.

9.1.4 Select a Task
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Figure 25.  Telelogic Synergy Select Task dialog box

The Telelogic Synergy Select Task dialog box will display the current task in the color purple.  Select 
the task that you want to set as your new current task by highlighting the task row, then click Select to 
set the task that you selected as the current task. 

If the task that you want to set as the current task is not available, you can create a new task by clicking 
Create Task.  This will allow you to create a new task, which will be set as the new current task.

Use the Open Project menu option or click the  Open Project icon to bring up the Open Telelogic 
Synergy Project dialog box.

9.1.5 Open Project
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   Figure 26.  Open Telelogic Synergy Project dialog box

The Open Telelogic Synergy Project dialog box will show all the projects that match the Project 
Scope that you selected.  Select the project and project version that you want to open, the click Open.  
The selected project version will now be added to your workspace.

Use the Show Telelogic Synergy menu option or click the  Show Telelogic Synergy icon to launch 
Telelogic Synergy.

9.1.6 Show Telelogic Synergy Interface
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Figure 27.  Telelogic Synergy Client Interface

Use the Work Offline menu option or click the  Work Offline icon to operate the integration offline.  
Once you select the Work Offline menu option or icon, the integration will automatically switch to Offline 
Mode.  The integration will not provide any of its normal capabilities while operating offline and any 
attempt to connect to a Telelogic Synergy database will not be allowed.

When the integration is in Offline Mode, the following conditions will apply:

 The integration will exit all running Telelogic Synergy sessions. 

 The integration will disable the Telelogic Synergy Taskbar and Menu with the exception of the 
Work Offline icon and menu option. 

 The integration will disable the Telelogic Synergy Team Menu. 

 The integration will disable the Telelogic Synergy Task and Change Request Views. 

 The integration will not allow users to rename Solutions, Solution files, Projects, and Project files 
within the Visual Studio IDE. 

 The integration will not allow users to move Solutions, Solution files, Projects, and Project files 
around within the Visual Studio IDE. 

 The move and rename operations are prevented while offline in order to prevent irreconcilable 
conflicts with the Telelogic Synergy database. 

Restrictions

9.1.7 Work Offline
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 Although the Save as, Rename, and Move operations are restricted while offline, certain 
restrictions do apply and are listed below: 

a.  Save as

 Solutions - When performing a Save as operation on Solutions, a new instance of the 
object will not be created and no objects will be changed. 

 Projects - When performing a Save as  operation on Projects, a new instance of the object 
will not be created, but if the read-only attribute of the Solution(.sln) file is enabled, the 
integration will automatically disable it. 

 Solution files - When performing a Save as  operation on Solution files, the integration will 
create a new instance of the object having the new name in the file system, but the 
original object will remain in the Solution Explorer and in the file system.  If the read-only 
attribute of the Solution(.sln) file is enabled, the integration will automatically disable it.  

Caution  If you perform the Save as operation on Solution files while offline and the read-
only attribute of the Solution(.sln) file is currently disabled, the Solution project will not be 
stored as a modified project even-though a new object was added in the file system. 

 Project files - When performing a Save as operation on Project files, the integration will 
create a new instance of the object having the new name in the file system and replace 
the original object in the Solution Explorer.  The original object will remain in the file 
system.  If the read-only attribute of the Project(.proj) file is enabled, the integration will 
automatically disable it. 

b.  Rename

 Solutions - The integration does not allow renaming of Solutions while offline. 

 Projects - The integration does not allow renaming of Projects while offline; however, if 
you attempt to rename a Project and the read-only attribute of the Solution(.sln) file is 
enabled, the integration will automatically disable it. 

 Solution files - The integration does not allow renaming of Solution files while offline; 
however, if you attempt to rename Solution files and the read-only attribute of the 
Solution(.sln) file is enabled, the integration will automatically disable it. 

 Project files - The integration does not allow renaming of Project files while offline; 
however, if you attempt to rename Project files and the read-only attribute of the Project
(.proj) file is enabled, the integration will automatically disable it. 

c.  Move into, Drag and Drop, and Copy and Paste

 Solutions - Solutions are restricted from being moved. 

 Projects - Projects are restricted from being moved. 

 Solution files - The integration will not allow you to perform the Move into operation on 
Solution files while offline; however, if you attempt to perform the Move into operation 
on Solution files and the read-only attribute of the destination Project(.proj) file is 
enabled, the integration will automatically disable it.  The integration does allow you to 
Drag and Drop and Copy and Paste Solution files to Projects. 

 Project files - The integration will not allow you to Drag and Drop or Copy and Paste
Project files to a Solution while offline; however, if you attempt to perform these 
operations and the read-only attribute of the Solution(.sln) file is enabled, the 
integration will automatically disable it.  The integration does allow you to Drag and 
Drop and Copy and Paste Project files between Projects. 

How to go back to Online Mode?

If you feel that you are finished working offline, you may easily notify the integration to reconnect to 

Telelogic Synergy.  To do this, select the Work Offline menu option or click the  Work Offline icon 
again and the integration will automatically switch back to Online Mode.

To read more about what happens when the integration returns to Online Mode, refer to the Going Back 
Online (Section 9.1.7.1) section.

When the integration returns back to Online Mode, the following conditions will apply:

 The integration will start all the Telelogic Synergy connections saved.  

 The integration will enable the Telelogic Synergy Taskbar and Menu. 

9.1.7.1 Going Back Online
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 The integration will enable the Telelogic Synergy Team Menu. 

 The integration will enable the Telelogic Synergy Task and Change Request Views. 

 The integration will again allow move and rename operations to be performed on Solutions, 
Solution files, Projects, and Project files from within the Visual Studio IDE.   

 The integration will notify you of any Solutions and Projects that were modified while the 
integration was offline.  This will be accomplished in the following ways: 

a.  When returning online, the integration will display a list of Solutions and Projects that were 
modified while working offline by using the Telelogic Synergy Synchronize Projects dialog box 
similar to the one displayed below. 

        Figure 27a.  Telelogic Synergy Synchronize Projects dialog box

The Telelogic Synergy Synchronize Projects dialog box will allow you to synchronize projects 
one at a time from the list.  Once a project has been synced, it will automatically be removed 
from the list.  If you choose not to synchronize the projects upon returning online, simply select 
Cancel.  Remember that choosing not to sync projects may result in work area conflicts.

Note  Once you have chosen a project from the list and selected Sync, make sure to 
finish synchronizing that project first before selecting another project from the list.  This means 
that keeping all the work area changes that you want from the Telelogic Synergy Work Area 
Conflicts dialog box and then exiting.

b.  Once you are back online, you will be able to use the Telelogic Synergy Team Menu options 
again.  If you attempt to perform a Team operation on a Solution or Project on the list that has not 
been synchronized, the integration will warn you that the project is out of synced by displaying a 
dialog box similar to the one displayed below.

   Figure 27b.  Out of Synced Project Warning dialog box.

The Out of Synced Project Warning dialog box will also ask whether you would like to sync the 
project now. 

 If you choose to sync the project now, the Team operation you are trying to perform will not 
continue for the selected Solution or Project.  Instead the Telelogic Synergy Work Area 
Conflicts dialog box will appear.  After you have finished synchronizing the project, you must 
re-select the Team operation to continue. 

 If you choose to sync the project later, the Team operation you are trying to perform will 
continue as normal. 
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The Task box is available with the Telelogic Synergy Taskbar.  This box is used to select/view the task 
for the current default Telelogic Synergy connection.

Figure 28.  Task box

The Task box will always display the current task for the default connection.  If there is no task set as 
current, the box will display NONE.  If there is no default Telelogic Synergy connection or the current 
default connection is not connected, the box will display Not Connected.

Figure 29a.  Task box displaying the default task for the default Connection

       Figure 29b.  Task box when no task is set

  Figure 29c.  Task box displaying Not Connected

You can use the Task box to connect to Telelogic Synergy.  To connect to Telelogic Synergy through the 
Task box, perform the following steps:

1.  Make sure that you have a default Telelogic Synergy connection set.  Refer to the Connection 
Management (Section 9.5.1) section for more information.

2.  On the Task box, select Connect to Telelogic Synergy . 

      Figure 30.  Task box's Connect to Telelogic Synergy option

3.  The integration will attempt to connect to Telelogic Synergy and the Connecting 
to Telelogic Synergy progress dialog box will appear.

Result:  A session will be started for the default connection.  The box will be populated with all of the 
assigned tasks for the corresponding session.

   Figure 31.  Task box populated with all of the assigned tasks

You can also use the Task box to disconnect the default connection from Telelogic Synergy.  To 
disconnect the default connection from Telelogic Synergy through the Task box, perform the following 
steps:

1.  On the Task box, select Disconnect From Telelogic Synergy .

9.1.8 Task Box

 

Telelogic Synergy for Microsoft Visual Studio Interface 3.4 | 40



   Figure 32.  Task box's Disconnect From Telelogic Synergy option

Result:  The session corresponding to the default connection will be disconnected and the Task box
will display Not Connected  (refer to Figure 29c).

Notes

  If there is no default connection set and you try to perform an action related to the Task 
box, you will be prompted to select a default connection. 

         Figure 33a.  Select a Default Connection prompt dialog box

  If no connections are available and you try to perform an action related to the Task box, you 
will be prompted to create a default connection. 

    Figure 33b.  Create a Default Connection prompt dialog box 

The integration uses Microsoft Visual Studio 2005 IDE's output window to show results of various source 
control operations.

  Figure 34.  Telelogic Synergy Output Window

You should use this view to check for any error or warning messages when performing version control 
operations.

Telelogic Synergy for Microsoft Visual Studio Interface provides the following views:

 Telelogic Synergy Task View (Section 9.3.1)

 Telelogic Synergy Change Request View (Section 9.3.2)

Notes

 If you rename or delete a saved task or change request query by using Telelogic Synergy and 
that query is currently being displayed in the view.

In order to update the information being shown on the Telelogic Synergy View(s), you must:

9.2 Telelogic Synergy Output Console Window

9.3 Telelogic Synergy Views
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1. Perform the Refresh operation on the view.

2. Re-expand the connection element that contained that saved task or change request query.

 If you rename a saved task or change request query by using Telelogic Synergy and that query 
is currently being displayed in the view. After you have perform the steps provided above, you 
must add the renamed query to the view again by performing the Add Saved Query operation.

Refer to one of the following sections to read more about the Add Saved Query  operation.

1. Add Saved Task Query (Section 9.3.3.2)

2. Add Saved Change Request Query (Section 9.3.3.3)

 

The integration provides a view designed to work with Telelogic Synergy tasks.

Note If you open the Telelogic Synergy Task View without creating any connections, the view will be 
empty.   

1.  The Telelogic Synergy Task View will display an element for each connection defined in the 
integration. 

 Each connection element will be decorated with the connection name.  

 The default connection will be represented by a green connection icon. 

 All other connections will be represented by a blue connection icon. 

 If there is no default connection defined, all connection elements will be represented by a blue 
connection icon. 

2.  Each connection element can be expanded to display the task queries saved for that connection. 

 Each task query will be decorated with the query name. 

 All task queries will be represented by a task query icon. 

 Initially, the integration will display three standard saved task queries for each connection: "My 
Assigned Tasks", "Tasks I Completed This Week", and "Tasks I Completed Last Week". 

3.  Each task query displayed in the view can be expanded to display all the tasks that match the given 
query.

 Each task will be decorated with the task number and the task synopsis. 

 All tasks will be represented by a task icon.  

4.  Each task displayed in the view can be expanded to show all the objects associated to that task.  

 Each object will be decorated with the file/folder name and its version. 

 All objects will be represented by either a file or folder icon.  If the object is a file, it will be 
represented by a file icon, and if the object is a folder, it will be represented by a folder icon. 

 The objects' icons will reflect their status.  Objects that are currently in working (checked out) 
state will be represented by a file/folder icon that is checked and objects that are currently 
in static (checked in) state will be represented by a file/folder icon that is unchecked.    

5.  You can drag and drop objects between assigned tasks.

 The integration will not allow you to drag and drop objects between completed tasks. 

 The integration will not allow you to drag and drop objects between different connections. 

Note The drag and drop feature in the Telelogic Synergy Task View is only available for objects.

9.3.1 Telelogic Synergy Task View
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       Figure 34.1. Telelogic Synergy Task View

The following toolbar operations are available from the Telelogic Synergy Task View.

1. Refresh View (Section 9.3.3.1)

2. Add Saved Query (Section 9.3.3.2)

The following pop-up menu operations are available from the Telelogic Synergy Task View.

  Task Queries

1. Cut (Section 9.3.4.1)

2. Refresh (Section 9.3.4.2)

 Tasks

1. View Task Properties (Section 9.3.4.4)

2. Complete Task (Section 9.3.4.5)

3. View Change Request Properties (Section 9.3.4.3)

 Objects

1. View Object Properties (Section 9.3.4.6)

The integration provides a view designed to work with Telelogic Synergy change requests.

Note If you open the Telelogic Synergy Change Request View without creating any connections, the 
view will be empty. 

1.  The Telelogic Synergy Change Request View will display an element for each connection defined in 
the integration. 

 Each connection element will be decorated with the connection name.  

9.3.2 Telelogic Synergy Change Request View
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 The default connection will be represented by a green connection icon. 

 All other connections will be represented by a blue connection icon. 

 If there is no default connection defined, all connection elements will be represented by a blue 
connection icon. 

2.  Each connection element can be expanded to display the change request queries saved for that 
connection.

 Each change request query will be decorated with the query name. 

 All change request queries will be represented by a change request query icon. 

 Initially, the integration will display one standard change request query for each connection: "My 
Assigned Change Requests". 

 If the Telelogic Synergy to Telelogic Change integration is not enabled for a connection, the 
integration will display a message stating: "Change Requests are not enabled on this connection" 
for that connection.  This will be the only element displayed below that connection node and the 
pop-up menu operations will be disabled for the connection. 

3.  Each change request query displayed in the view can be expanded to display all the change requests 
that match the given query.

 Each change request will be decorated with the change request number and the change request 
synopsis. 

 All change requests will be represented by a change request icon. 

4.  Each change request displayed in the view can be expanded to display all the tasks associated with 
that change request.

 Each task will be decorated with the task number and the task synopsis. 

 All tasks will be represented by a task icon. 

5.  Each task displayed in the view can be expanded to show all the objects associated to that task.

 Each object will be decorated with the file/folder name and its version. 

 All objects will be represented by either a file or folder icon.  If the object is a file, it will be 
represented by a file icon, and if the object is a folder, it will be represented by a folder icon. 

 The objects' icons will reflect their status.  Objects that are currently in working (checked out) 
state will be represented by a file/folder icon that is checked and objects that are currently in 
static (checked in) state will be represented by a file/folder icon that is unchecked. 

6.  You can drag and drop tasks between assigned change requests.

 The integration will not allow you to drag and drop tasks between change requests that are not 
assigned. 

 The integration will not allow you to drag and drop tasks between different connections.  

7.  You can drag and drop objects between assigned tasks.

 The integration will not allow you to drag and drop objects between completed tasks. 

 The integration will not allow you to drag and drop objects between different connections. 

Note The drag and drop feature in the Telelogic Synergy Change Request View is only available for 
tasks and objects.
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          Figure 34.2. Telelogic Synergy Change Request View

The following toolbar operations are available from the Telelogic Synergy Change Request View.

1. Refresh View (Section 9.3.3.1)

2. Add Saved Query (Section 9.3.3.3)

The following pop-up menu operations are available from the Telelogic Synergy Change Request 
View.

  Change Request Queries

1. Cut (Section 9.3.4.1)

2. Refresh (Section 9.3.4.2)

 Change Requests

1. View Change Request Properties (Section 9.3.4.3)

 Tasks

1. View Task Properties (Section 9.3.4.4)

2. Complete Task (Section 9.3.4.5)

3. View Change Request Properties (Section 9.3.4.3)

 Objects

1. View Object Properties (Section 9.3.4.6)

The Telelogic Synergy Views offer a quick way to refresh and add queries to the view through the use 
of the following toolbar operations:

1. Refresh View (Section 9.3.3.1)

2. Add Saved Task Query (Section 9.3.3.2) (only available in the Telelogic Synergy Task 
View) 

9.3.3 Toolbar Operations
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3. Add Saved Change Request Query (Section 9.3.3.3) (only available in the Telelogic 
Synergy Change Request View) 

 The Telelogic Synergy Views' toolbar

Use the Refresh icon from the Telelogic Synergy View's toolbar (task or change request) to 

update the contents of the view.  Simply click the  icon and the contents of the view will be updated.

You may display additional saved task queries to the Telelogic Synergy Task View. 

To add a task query to the Telelogic Synergy Task View, perform the following steps:

1.  Click the  Add Saved Query icon from the Telelogic Synergy Task View's toolbar.

2.  The Select Query dialog box will appear on the screen.

    Figure 34.3. Select Query dialog box for the Telelogic Synergy Task View

 The Select Query dialog box will initially display the saved task queries for the default 
connection.  

 The task queries that you created will be displayed in bold font.  Other task queries will be 
displayed in regular font. 

 If there is no default connection set, the Select Query dialog box will display NONE in the 
Connection Name box. 

3.  Select the Connection Name and task query that you want to add to the view.

4.  Click OK to add the selected task query to the Telelogic Synergy Task View.

You may display additional saved change request queries to the Telelogic Synergy Change Request 
View.

To add a change request query to the Telelogic Synergy Change Request View, perform the following 

9.3.3.1 Refresh View

9.3.3.2 Add Saved Task Query

9.3.3.3 Add Saved Change Request Query
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steps:

1.  Click the  Add Saved Query icon from the Telelogic Synergy Change Request View's toolbar.

2.  The Select Query dialog box will appear on the screen.

Figure 34.4. Select Query dialog box for the Telelogic Synergy Change Request View

 The Select Query dialog box will initially display the saved change request queries for the default 
connection.  

 The change request queries that you created will be displayed in bold font.  Other change request 
queries will be displayed in regular font. 

 If there is no default connection set, the Select Query dialog box will display NONE in the 
Connection Name box. 

 If the connection selected does not have the Telelogic Synergy to Telelogic Change integration 
enabled, the Select Query dialog box will display NONE in the change request query list box. 

3.  Select the Connection Name and change request query that you want to add to the view.

4.  Click OK to add the selected change request query to the Telelogic Synergy Change Request 
View.

With the exception of connection elements, the Telelogic Synergy Views provide the following menu 
operations:

  Queries

1. Cut (Section 9.3.4.1)

2. Refresh (Section 9.3.4.2)

 Change Requests

1. View Change Request Properties (Section 9.3.4.3)

 Tasks

1. View Task Properties (Section 9.3.4.4)

2. Complete Task (Section 9.3.4.5)

3. View Change Request Properties (Section 9.3.4.3)

 Objects

1. View Object Properties (Section 9.3.4.6)

9.3.4 Pop-Up Menu Operations

9.3.4.1 Cut a Query
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To cut a query from the view, perform the following steps:

1.  On the Telelogic Synergy View, select the query (task or change request) that you want to remove 
from the view. 

2.  Right-click on the selected query and select Cut from the menu options.  The query selected will be 
removed from the Telelogic Synergy View.

Note When you perform the Cut operation on a query (task or change request), the query will not be 
deleted, it will only be removed from the Telelogic Synergy View.

To refresh the contents of a query, perform the following steps:

1.  On the Telelogic Synergy View, select the query (task or change request) that you want to refresh.

2.  Right-click the selected query and select Refresh from the menu.  The query's contents will now be 
updated.

To view the properties of a change request, perform the following steps:

1.  On the Telelogic Synergy View, select the change request that you want to view. 

2.  Right-click on the selected change request and select Properties from the menu. 

     The Telelogic Change show form for the selected change request will appear on the screen.

If you want to view the properties for a change request that is associated to a task, perform the following 
steps:

1.  On the Telelogic Synergy View, select the task whose change request properties you want to view. 

2.  Right-click the selected task and select Change Request Properties from the menu options.

     The Telelogic Change show form for the change request that is associated to the selected task will 
appear on the screen.

9.3.4.2 Refresh a Query

9.3.4.3 View Change Request Properties
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    An example of a Telelogic Change show form for a change request.

To view the properties of a task, perform the following steps:

1.  On the Telelogic Synergy View, select the task that you want to view.

2.  Right-click on the selected task and select Properties from the menu.

     The Task Properties dialog box for the selected task will appear on the screen.

9.3.4.4 View Task Properties
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An example of a Task Properties dialog box.

To complete a task from the Telelogic Synergy View(s), perform the following steps:

1.  On the Telelogic Synergy View, select the task that you want to complete.

2.  Right-click the selected task and select Complete from the menu.

     The Complete Task dialog box will appear on the screen.

9.3.4.5 Complete Task
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 The task that you selected will be shown in the Complete Task dialog box. 

 If the task that you selected is already completed, the default task will be selected in the 
Complete Task dialog box.  If no default task is set, the first task listed in the Assigned Tasks
box will be selected; otherwise, no task will be selected. 

To view the properties of an object, perform the following steps:

1.  On the Telelogic Synergy View, select the object that you want to view.

2.  Right-click the selected object and select Properties from the menu. 

     The Telelogic Synergy Properties dialog box for the selected object will appear on the screen.

9.3.4.6 View Object Properties
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       An example of a Telelogic Synergy Properties dialog box for a file.

An example of a Telelogic Synergy Properties dialog box for a folder/directory.

9.4 Symbols and Tooltips
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Symbols
When a Solution and/or Project in Microsoft Visual Studio is connected to Telelogic Synergy, the Solution 
and Project files are decorated to give a visual indication that the project is under Telelogic Synergy.  The 
following information describes what each symbol indicates.

 Checked Out - The object is currently checked out and modifiable. 

 Checked Out by Another User - The Solutions and Projects controlling the object are checked 
out using a Shared  Purpose and the object is currently checked out by another user. 

 

 Checked In - The object is currently checked in and not modifiable. 

Tooltips
The integration displays additional information about a project/file/folder through the use of tooltips.  You 
can invoke the tooltips by performing the following:

1.  In the Microsoft Visual Studio Solution Explorer, place the mouse tip over the project/file/folder icon.

2.  You should see source control information about the project/file/folder, such as its name, version, 
owner, status, and release.

For example: name-version:owner:status:release

Note  Although folders/directories support version control operations, symbols and tooltips will not be 
visible for folders/directories.

You can manage the Telelogic Synergy integration settings by using the Settings menu option or by 

clicking the  Settings icon. This feature specifies how the integration will function and connect to 
Telelogic Synergy.

Read the following information to understand more about how to manage the Telelogic Synergy 
integration settings.

1.   Use the Settings menu option or click the  Settings icon to bring up the Telelogic Synergy 
Settings dialog box.

2.   The Telelogic Synergy Settings dialog box will display as shown below.

9.5 Settings

 

Telelogic Synergy for Microsoft Visual Studio Interface 3.4 | 53



       Figure 35. Telelogic Synergy Settings dialog box

3.   The Telelogic Synergy Settings dialog box offers the following settings management options.  Click 
on the links to learn more about each topic.

 Connection Management (Section 9.5.1)

 General Settings (Section 9.5.2)

4.   View/Modify the options offered by the Telelogic Synergy Settings dialog box.  

5.   When you are finished, click OK to save the changes that you have made and exit the Telelogic 
Synergy Settings dialog box. 

This feature specifies how the integration will connect to Telelogic Synergy.  The following Connection 
Management operations are available in the Telelogic Synergy Settings dialog box through a menu 
option called Connection Management.

  Connection Management menu

Connection Management offers the following capabilities:

 Add Connection - This operation will bring up a New Telelogic Synergy Connection  dialog 
box similar to the one shown below.  If the connection being added is the first connection or if 

9.5.1 Connection Management
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there is currently no default connection set, the connection will be set as the default connection; 
otherwise, it will be set as a regular connection.

    Figure 36. New Telelogic Synergy Connection dialog box

Fill in the connection information (Connection Name, User Name, Password, Database Path, 
Engine Host, Client Home, and Client Database).  Make sure that all the fields are filled in, 
then click Connect to save the connection and start a Telelogic Synergy session.

 

 Start Session - You can explicitly start a Telelogic Synergy session for a certain connection by 
selecting the connection in the Telelogic Synergy Settings dialog box and clicking Start.  If you 
perform a source control or task operation and a session is not already started, the integration will 
automatically start the default connection.  

Note  Clicking twice on Start will not start another session.  If a session is explicitly (by clicking Start) 
or implicitly (performing a team operation) started from the integration, it will reuse a session 
already started by the integration.

 

 Delete Connection - This operation will delete the selected connection.  If the selected connection 
has a session running, the session will be terminated before deleting the connection.  If you want to 
delete a connection that is being used by a Solution in Visual Studio, you must Disconnect the 
Solution first. 

 

 Stop Session - This operation will stop the Telelogic Synergy session for the selected connection. 

 

 Make Default - The connection that you select will become the default connection.  The default 
connection is the connection that will automatically be used in all Task dialog boxes and project 
wizards. 

 

 Clear Default - This operation will clear the default connection.  This means that no default 
connection is set.  If there is no default connection, NONE will appear in the Connection Name field 
wherever applicable.  The Show Task and Show Telelogic Synergy taskbar and menu options and 
the Task box option will not be available when no default connection is set.  

 

 Properties - You are allowed to view the connection properties by simply double-clicking a 
connection or selecting the Properties option from the Connection Management menu.  When the 
connection is currently in Connected status (see figure 37a), you may not modify the connection 
properties.  You may only modify the connection properties when the connection is in Disconnected
status (see figure 37b). 

Note  The Connection Name cannot be changed. 
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Figure 37a.  Telelogic Synergy Connection Properties dialog box with a Connected 
connection

Figure 37b.  Telelogic Synergy Connection Properties dialog box with a Disconnected 
connection

This feature of the integration specifies how the integration will function with Telelogic Synergy.  You may 
configure your Telelogic Synergy integration settings by setting the following options according to your 
preference.

The following information will describe the functionalities of each General Settings option.  Set the 
following preferences by checking the check box next to the option.

1.  Check Out file(s) automatically when edited

 When the Check Out file(s) automatically when edited option is selected, the 
following will occur: 

 The integration will automatically check out files when you modify them. 

 The integration will update the symbols to represent the updated source control status 
of the files. 

 When the Check Out file(s) automatically when edited option is cleared, the following 
will occur: 

9.5.2 General Settings
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 When you attempt to modify any file, the integration will display the following dialog 
box. 

Figure 38a.  Telelogic Synergy Check Out File prompt dialog box

 You must select Yes to check out the file.  If you select No, you can continue to 
modify the file; however, when you try to save the file at a later time, the integration 
will once again prompt you to check out the file in order to keep your changes. 

 Once the file is properly checked out, the integration will update the symbol to 
represent the updated source control status of the file. 

2.  Prompt to add new project files to Telelogic Synergy - This option is used when new files are 
added to the connected Project/Solution.

 When the Prompt to add new project files to Telelogic Synergy option is selected, the 
following will occur: 

 When you add new project files to a Project/Solution, the integration will prompt you 
to add the files to Telelogic Synergy by displaying the Telelogic Synergy Add Files
dialog box. 

Figure 38b.  Telelogic Synergy Add Files dialog box

 Click Add to add the files to Telelogic Synergy.  You should see the Add 
Uncontrolled Files progress dialog box appear. 

 The files will now be controlled under Telelogic Synergy. 

 When the Prompt to add new project files to Telelogic Synergy option is cleared, the 
following will occur: 

 When you add new project files to a Project/Solution, those files will not be controlled 
under Telelogic Synergy.  You must add the uncontrolled files to Telelogic Synergy in 
order to perform source control operations on them. 

 Refer to the section How to add new files and folders to database (Section 
10.4) to read more about adding uncontrolled files/folders to Telelogic Synergy. 

3.  Notify for parallel versions on check out

4.  Notify for parallel versions on check in

5.  Prompt for the DB case mode information - This option will be selected by default.

  When the Prompt for the DB case mode information option is selected, the following will 
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occur: 

 When you perform any of the operations listed below, the integration will prompt you 
to select the proper database case mode that was used when the Solutions or Projects 
were migrated to Telelogic Synergy.  The integration will display the Select 
Database Mode dialog box, which will allow you to select the proper database case 
mode to use.  

      Figure 38c.  Select Database Mode dialog box

1. Connecting Solutions/Projects to Telelogic Synergy by using the Connect option 
from the Telelogic Synergy team menu. 

2. Opening Solutions/Projects by using the Open Project option from the Telelogic 
Synergy taskbar. 

3. Copying Solutions/Projects by using the Copy Project option from the Telelogic 
Synergy taskbar. 

 When the Prompt for the DB case mode information option is cleared, the following will 
occur: 

 The integration will not display the Select Database Mode dialog box when you 
perform any of the same three operations listed above: Connect, Open Project, and 
Copy Project.  By default, the integration will use the database case 
mode PRESERVE to perform all operations, including the Connect, Open Project, 
and Copy Project operations.  

 If you set all of your database(s) to PRESERVE case after installing the integration 
and you never set it back to LOWER or UPPER case, it is recommended that you turn 
off the Prompt for the DB case mode information option. 

The Synergy "smart-card" login feature that is included in Telelogic Synergy is also available in Telelogic 
Synergy for Microsoft Visual Studio Interface.  The "smart-card" feature will allow users of the integration 
to create a connection without the need to enter a username and password. 

Note For more information on how to enable/disable the Synergy "smart-card" login feature in Telelogic 
Synergy, refer to the Telelogic Synergy Help.

 If the Synergy "smart-card" feature in Telelogic Synergy is enabled and you try to create a new 
Synergy Connection, the User Name and Password text field will be disabled in the New 
Telelogic Synergy Connection dialog box.  The User Name text field will automatically be filled 
in with the user's operating system username.  You will still need to fill in the remaining 
information: Connection Name, Database Path, Engine Host, Client Home, and Client 
Database. 

9.6 Telelogic Synergy 'smart-card' login feature
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Figure 38d. New Telelogic Synergy Connection dialog box with "smart-card" feature 
enabled

 If the Synergy "smart-card" feature in Telelogic Synergy is disabled and you try to create a new 
Synergy Connection, the User Name, Password, and all of the remaining Connection 
information text fields will be enabled in the New Telelogic Synergy Connection  dialog box.  
You must fill in all of the text fields in order to create a new Connection and start a Synergy 
session. 

Figure 38e. New Telelogic Synergy Connection dialog box with "smart-card" feature 
disabled
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Daily development refers to the activities performed by the team members during everyday 
development.  Once a development or a build management project is set up, daily development primarily 
involves the activities of modifying files.  Telelogic Synergy is a task-based configuration management.  
In order to keep track of daily development activities effectively, you should associate them with a 
Telelogic Synergy task.  This section also describes many other operations that can be performed by 
using the integration.

Most of these operations are available from the Telelogic Synergy team menu.  Below is a picture of the 
Telelogic Synergy team menu.

Figure 39. Telelogic Synergy team menu

The Telelogic Synergy team menu can be invoked by using Microsoft Visual Studio's main menu.  
Simply click File, then select Telelogic Synergy.  You can also invoke the Telelogic Synergy team 
menu by right clicking on a Solution, Project, folder, or file in Visual Studio's Solution Explorer.

Whenever you check out a file, the check-out operation is tracked with your current task.  You should 
select a current task before you check out or modify any file.  When you are done, you should check in 
your current task instead of checking in the individual files.  To complete a task or to create a task, use 
the Telelogic Synergy taskbar and/or menu.

 You can set a current task for each Telelogic Synergy Connection.  To do this, you can use the 
Telelogic Synergy taskbar or menu by choosing the Select Task (Section 9.1.4) option. 

 You can use the Task box from the Telelogic Synergy taskbar to find out what current task is set 
for the default connection. Or you can use the Select Task (Section 9.1.4) option from the 
Telelogic Synergy taskbar or menu to view the current task for each connection.  Simply choose 
the Connection Name and its corresponding current task will be displayed in the Current Task
box.  If there is no current task set for the connection, you will see NONE in the Current Task
box. 

The integration will at times prompt you to select a current task if you perform an operation which 

10 Daily Development

10.1 How to Use Task-Based CM
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requires a task. 

Figure 40. Set Default Task prompt dialog box

You can either select an existing task as your current task or create a new task.

To connect a Solution/Project to Telelogic Synergy, perform the following steps.  After performing this 
operation, the Solution/Project opened in Microsoft Visual Studio will be connected to Telelogic Synergy. 

1.  Open the Solution/Project by clicking Microsoft Visual Studio's File > Open > Project/Solution.

2.  Select the Solution/Project that you want to connect.

3.  On the Telelogic Synergy team menu, select the Connect option.  The Select Connection dialog 
box will appear.  You must select the connection that you want to use to connect the Solution/Project.

   Figure 41.  Select Connection dialog box

4.  Select a connection from the list and click Select to connect the Solution/Project.

The selected Solution/Project will now be connected to Telelogic Synergy.  The integration will add the 
appropriate symbols to the Solution/Project and its files and directories.

Note  If at a later time, you decide to disconnect the Solution/Project, you may do so by executing the 
Disconnect operation.  Refer to the How to Disconnect a Solution or Project (Section 
10.16) section to learn more about the Disconnect operation. 

When you create a new project in Microsoft Visual Studio and you add that project to a Solution that is 
already controlled under Telelogic Synergy, you will need to migrate your newly created project to 
Telelogic Synergy in order to perform source control operations on the project and its files.

To migrate a project to Telelogic Synergy, perform the following steps:

1.  On the Solution Explorer, select your newly added/created project.

10.2 How to Connect a Solution or Project

10.3 How to Migrate Projects
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2.  On the Telelogic Synergy team menu, select Create Project in Telelogic Synergy.  The Create 
Project in Telelogic Synergy dialog box will appear.

Note:  The Create Project in Telelogic Synergy dialog box will not allow you to create the Solution 
in Telelogic Synergy.  You will not need to migrate the Solution to Telelogic Synergy again because 
the Solution is already controlled as a project in Telelogic Synergy.

     Figure 42.  Create Project in Telelogic Synergy dialog box

There are important cases that you need to be aware of when migrating projects to Telelogic Synergy.

1. When migrating a project that is located inside the Solution directory in the file system, the 
project must be migrated to the same Telelogic Synergy database as the Solution.  This 
means that you will not be able to change the Connection Name when creating the project 
in Telelogic Synergy. 

2. When migrating a project that is located outside the Solution directory in the file system, you 
can migrate the project to any Telelogic Synergy database. This means that you will be 
allowed to change the Connection Name selected in order for the project to be migrated 
to the proper Telelogic Synergy database that you desire. 

3.  Click Create to migrate the project to Telelogic Synergy.  The Create Projects progress dialog box 
will appear.

4.  Once the project is migrated to Telelogic Synergy, Microsoft Visual Studio will display a File 
Modification Detected dialog box (see Figure 43a). 
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Figure 43a.  File Modification Detected dialog box

5.  Click Reload on the File Modification Detected dialog box to see the project and its files properly 
decorated with symbols in the Solution Explorer.

Figure 43b.  Solution Explorer containing the decorated project files

6.  Click File > Save All in the Microsoft Visual Studio 2005 main menu.

7.  When you exit the Microsoft Visual Studio 2005 IDE, Visual Studio will prompt you to save the Solution 
by displaying a dialog box similar to the one displayed below.  Click Yes to save the current state of your 
Solutions and projects.  Your project is now controlled under Telelogic Synergy.

          Figure 43c.  Save Solution Prompt dialog box

If you add new files or folders to your workspace, you should add them to Telelogic Synergy as soon as 
possible.

Notes 

 If the Telelogic Synergy Settings option, Prompt to add new project files to Telelogic 
Synergy is selected, the integration will automatically prompt you to add new files to Telelogic 

10.4 How to add new files and folders to database
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Synergy.  The Prompt to add new project files to Telelogic Synergy option only applies to 
uncontrolled files.  In order to add uncontrolled folders to Telelogic Synergy, you must use the 
Add Uncontrolled Files Telelogic Synergy team menu option. 

 It is important that if you add files/folders to your Solutions/Projects, you should also add them to 
Telelogic Synergy as soon as possible.  You must have a current task set in order to perform the 
Add Uncontrolled Files operation. 

 The integration will find the ignored files/folders and those files/folders will not be added to 
Telelogic Synergy.  

 The Add Uncontrolled Files  operation will leave the added files in the checked-out state. 

To add uncontrolled files/folders to Telelogic Synergy, perform the following steps:

1.  Select the uncontrolled files/folders that you want to add to Telelogic Synergy.

2.  On the Telelogic Synergy team menu, click Add Uncontrolled Files .  The Telelogic Synergy Add 
Files dialog box will appear.

Figure 44. Telelogic Synergy Add Files dialog box

3.  Click Add to add the selected files/folders to Telelogic Synergy.

A progress dialog box that depicts the status of the Add Uncontrolled Files operation will appear.  The 
files/folders that you selected are now controlled by Telelogic Synergy.

If you no longer want to control certain files in Telelogic Synergy, you may remove them. 

Notes

 The Remove From Telelogic Synergy  operation will remove the files from your 
Solutions/Projects and from Telelogic Synergy.  In case you want to keep these files on your local 
drive, you should save a copy before performing this operation. 

 Microsoft Visual Studio offers two additional operations called Exclude From Project and 
Delete.  Exclude From Project will remove the Solution and Project files from your 
Solutions/Projects.  Delete will remove the Solution and Project files from your Solutions/Projects 
and from the file system.  

 When you perform the Exclude From Project or Delete operations on Solution and Project files 
that are controlled by Telelogic Synergy, the integration will display the Delete files prompt
dialog box (see Figure 45).  If you respond Yes to the dialog box, the Solution and Project files 
will be removed from your Solutions/Projects and from Telelogic Synergy.  If you respond No to 
the dialog box, the Solution and Project files will only be removed from your Solutions/Projects 
and not from Telelogic Synergy. 

10.5 How to remove files from database
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             Figure 45.  Delete files prompt dialog box

 When you perform the Exclude From Project or Delete operations on Solution and 
Project folders/directories that are controlled by Telelogic Synergy, the integration will display the 
Delete files prompt dialog box (see Figure 45) twice.  You must then respond twice to the dialog 
box.  This limitation is one of the known issues of Telelogic Synergy for Microsoft Visual Studio 
Interface. 

To remove controlled files from Telelogic Synergy, perform the following steps:

1.  Select the files that you want to remove from Telelogic Synergy.

2.  On the Telelogic Synergy team menu, click Remove From Telelogic Synergy .  The Telelogic 
Synergy Remove Files dialog box will appear.

        Figure 46. Telelogic Synergy Remove Files dialog box

3.  Click Remove to remove the selected files from Telelogic Synergy.

A progress dialog box that depicts the status of the Remove From Telelogic Synergy operation will 
appear.  The files that you selected are now removed from Telelogic Synergy.

Occasionally, your work area may not be in sync with Telelogic Synergy.  This might happen if you modify 
files outside of Microsoft Visual Studio without performing a check-out operation.

To synchronize your work area, perform the following steps:

1.  Select the Solution or Project that you need to sync.

2.  On the Telelogic Synergy team menu, click Sync.

3.  If there are work area conflicts, the Telelogic Synergy Work Area Conflicts dialog box will appear. 

10.6 How to Synchronize a Work Area
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Figure 47. Telelogic Synergy Work Area Conflicts dialog box

4.   A list of work area conflicts will be listed in the dialog box. 

 Keep the work area changes that you want by selecting the files and clicking the Keep Work 
Area Changes icon at the top of the dialog box or by right clicking on the files and selecting the 
Keep Work Area Changes option.  

 Discard the work area changes that you don't want by following the same procedure but choose 
the Discard Work Area Changes icon or Discard Work Area Changes option instead. 

      By performing the above operation, the working files/folders may automatically be checked out.  In 
order for the objects to reflect their updated version control status symbols, you must refresh the status 
of the objects by performing the Refresh Status operation available from the Telelogic Synergy team 
menu.  To read more about the Refresh Status operation, refer to the How to Refresh the Version 
Control Status (Section 10.15) section.

Note  If you need further help understanding the Sync operation or the Telelogic Synergy Work Area 
Conflicts dialog box, go to the Telelogic Synergy Help.

You must check out files before you can start modifying them. 

Notes

 The Check Out and Check Out Recursive operations are only valid for controlled 
Solutions/Projects/files/folders. 

 Only the selected files will be checked out.  To check out a Solution/Project/folder's contents all at 
one time, use the Check Out Recursive operation.  

 If you perform the Check Out operation on a file that is located inside a folder, the file and its 
folder will automatically be checked out. 

 This operation requires a task.  If you choose not to specify a current task, the integration will 
prompt you to select a task. 

 The following behavior is preference based and can be set by choosing the Settings option in the 
Telelogic Synergy taskbar or menu.  If after executing the Check Out or Check Out Recursive
operation, the selected files results in parallel versions, you will receive a warning.  (To read more 
about Telelogic Synergy General Settings, go to General Settings (Section 9.5.2)). 

To check out files, perform the following steps:

10.7 How to Check Out
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1.  On the Solution Explorer, select the files that you want to check out.  If you want to perform the 
Check Out Recursive operation, select only the top most level Solution/Project/file/folder.

2.  On the Telelogic Synergy team menu, click Check Out or click Check Out Recursive to check out 
the selected Solution/Project/folder contents. 

3.  If you selected the Check Out Recursive option, the following Telelogic Synergy CheckOut 
Operation dialog box will appear.

Figure 48.  Telelogic Synergy CheckOut Operation dialog box

4.  Select/Change your current task and write an appropriate check out comment, then click CheckOut to 
check out the files.

The symbol representing Checked Out will be displayed next to the file names.

Notes

 The current version of the file/folder will be replaced with the previous version.  If the file/folder 
has only one version, you will be notified. 

 If you perform the Undo Checkout operation on a file that is located inside a folder, the 
integration will automatically undo check out of the file and its folder. 

 The integration will not allow the Undo Checkout operation to be performed on files and 
directories that have been checked out as a result of a Rename operation.  You may perform the 
Undo Checkout operation on these types of files by using one of the following methods: 

1. You can rename the files and/or directories back to their previous names by using Microsoft 
Visual Studio IDE's Rename option. 

2. You may Save then Close the Solution containing the files and/or directories, perform the 
Undo Checkout operation on the Project file and the files and/or directories by using 
Telelogic Synergy's Delete option, then re-open the Solution in the Microsoft Visual Studio 
IDE. 

To undo the check out of files, perform the following steps:

1.  On the Solution Explorer, select the files that you do not want checked out.  If you want 
to perform the Undo Checkout Recursive operation, select only the top most level 
Solution/Project/file/folder.

10.8 How to Undo Check Out
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2.  On the Telelogic Synergy team menu, click Undo Checkout or click Undo Checkout Recursive to 
undo check out of the selected Solution/Project/folder contents. 

3.  If you selected the Undo Checkout Recursive option, the following Telelogic Synergy Undo 
CheckOut Operation dialog box will appear.

      Figure 49.  Telelogic Synergy Undo CheckOut Operation dialog box

4.  Click Undo to undo check out of the files.

The symbol representing the current source control status of the files will be displayed next to the file 
names.

Notes

 The following behavior is preference based and can be set by choosing the Settings option in the 
Telelogic Synergy taskbar or menu.  When performing the Check In operation on files that have 
parallel versions, you will receive a notification.  (To read more about Telelogic Synergy General 
Settings, go to General Settings (Section 9.5.2)). 

 Telelogic recommends that you complete your task rather than checking in individual files. 

 The Check In and Check In Recursive operations should only be used when it is absolutely 
necessary to check in files/folders before the task is complete. 

To check in files, perform the following steps:

1.  On the Solution Explorer, select the files that you want to check in.  If you want to perform the Check 
In Recursive operation, select only the top most level Solution/Project/file/folder.

2.  On the Telelogic Synergy team menu, click Check In or click Check In Recursive to check in the 
selected Solution/Project/folder contents. 

3.  If you selected the Check In Recursive option, the following Telelogic Synergy CheckIn 
Operation dialog box will appear.

10.9 How to Check In
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  Figure 50.  Telelogic Synergy CheckIn Operation dialog box

4.  Click CheckIn to check in the files.

The symbol representing Checked In will be displayed next to the file names.

Notes

 The Compare with Predecessor operation is only available for files and folders. 

 If a file or folder has more than one predecessor, the Telelogic Synergy Compare dialog box 
will appear for each predecessor. 

 If you need further help understanding the Compare with Predecessor operation, the 
Telelogic Synergy Compare dialog box, or the Telelogic Synergy Directory Compare dialog 
box, go to the Telelogic Synergy Help. 

To compare a version of a file or folder with its predecessor, perform the following steps:

1.  On the Solution Explorer, select the the files/folders on which you want to perform the Compare with 
Predecessor operation.

2.  On the Telelogic Synergy team menu, click Compare with Predecessor. 

 When comparing files with its predecessor, the Telelogic Synergy Compare dialog box will look 
similar to Figure 51.  

10.10 How to Compare a File or Folder with its Predecessor
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     Figure 51. Telelogic Synergy Compare dialog box for files

 When comparing folders with its predecessor, the Telelogic Synergy Directory Compare dialog 
box will look similar to Figure 52. 

 

       Figure 52. Telelogic Synergy Directory Compare dialog box

10.11 How to see History of Objects
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To view the history of objects, perform the following steps:

1.  On the Solution Explorer, select the object of which you want to view the history. 

2.  On the Telelogic Synergy team menu, click History. 

3.   The Telelogic Synergy History dialog box will appear as shown below for the selected object.

Figure 53. Telelogic Synergy History dialog box

(File-Folder Properties.html)

To view or modify the properties of an object, perform the following steps:

1.  On the Solution Explorer, select the object on which you want to view the properties. 

2.  On the Telelogic Synergy team menu, click Properties. 

3.   The Telelogic Synergy Properties dialog box will display and look similar to Figure 54a or 54b, 
depending on the type of object that was selected.

10.12 How to view or modify properties of objects
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Figure 54a.  Telelogic Synergy Properties dialog box for Solutions/Projects

     Figure 54b. Telelogic Synergy Properties dialog box for directories/files

4.   View and/or modify the available properties.  If you need further help understanding the Telelogic 
Synergy Properties dialog box, go to the Telelogic Synergy Help.

Note  If you modify the Version, it is important that you refresh the status of the object (Solution, 
Project, folder, or file) in order to see the updated version control status symbols.  To learn how to 
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refresh the status of objects, refer to the How to Refresh the Version Control Status (Section 
10.15) section.

There are times when you might want to change the version being used for a file or folder.

To use a different version of a file or folder, perform the following steps:

1.  Select the file or folder on which you want to perform the Use Version operation.  You may only 
select one file/folder at a time.

2.  On the Telelogic Synergy team menu, select Use Version.

3.  The Use Version dialog box will appear for the selected file or folder.  The version that is currently 
being used by the file/folder will have a checkbox that is selected.

       Figure 55.  Use Version dialog box

4.  Select the version that you want to use.  You can click Recommend to see the recommended/latest 
version of the file/folder.  When the Recommend button is clicked, the recommended version will be 
highlighted. 

5.  Click Use to change the version of the file/folder to the one that you selected.  The integration will 
then update the corresponding symbols to reflect the file/folder's new source control status.

Note  You can also use the Telelogic Synergy team menu's History option to change the version being 
used for a file or folder.

To get the latest version of project files, perform the following steps:

1.  Select the objects on which you want to perform the Update Members operation.

2.  On the Telelogic Synergy team menu, select Update Members.  The Update Members Progress
dialog box will appear.

The selected objects will be updated.  The result of the Update Members operation will be displayed in 
the Telelogic Synergy Output Console Window. 

Note  If you perform the Update Members operation on a project, the project will be updated.  You can 
select multiple projects for this operation.  If you need further help understanding the Update Members
operation, go to the Telelogic Synergy Help.

If a source control operation is performed on the project files outside of the Microsoft Visual Studio 2005 

10.13 How to Use a Version of a File or Folder

10.14 How to Update Members

10.15 How to Refresh the Version Control Status
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IDE, the integration will not be able to display the correct symbol in the Solution Explorer (Refer to the 
Symbols and Tooltips (Section 9.4) section to read more about symbols).  In order for the integration 
to display the proper symbol representing the most up-to-date status of the project files, you can use the 
Refresh Status operation.

To refresh the version control status of objects, perform the following steps:

1.  Select the objects (Solutions/Projects, directories, or files) on which you want to refresh the source 
control status.

2.  On the Telelogic Synergy team menu, select Refresh Status.

The selected objects will now show the current source control status.

In case you want your Solutions and/or Projects to behave as if there was no source control installed, you 
may disconnect your Solutions and/or Projects. 

After performing the Disconnect operation, the Solution/Project opened in Microsoft Visual Studio will be 
disconnected from Telelogic Synergy.  To disconnect a Solution/Project from Telelogic Synergy, perform 
the following steps.

1.  Select the Solution/Project that you want to disconnect.

2.  On the Telelogic Synergy team menu, select Disconnect.

The selected Solution/Project will now be disconnected from Telelogic Synergy.  The integration will 
remove the corresponding symbols for the Solution/Project and its files and directories.

Note  You will be able to connect the Solution/Project again by executing the Connect operation.  Refer 
to the How to Connect a Solution or Project (Section 10.2) section to learn more about the Connect
operation.

The integration provides support for debugging.  Debug support will track your activities while using the 
integration.  You may use the information provided by the Debug support to view or correct any errors or 
warnings that may occur while using the integration.

A registry entry called the DebugLevel will be created once Telelogic Synergy for Microsoft Visual Studio 
Interface is installed.  You may view or change the value of the DebugLevel according to your preference 
by using the Registry Editor.  An example of the Registry Editor is displayed below.

10.16 How to Disconnect a Solution or Project

10.17 Debugging Support
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Figure 56.  Registry Editor

The registry key DebugLevel will be in the following location:

 My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Telelogic\CM SYNERGY\Integrations\ccmdc

To change the value of the debug level, perform the following steps:

1.  Open the Registry Editor dialog box.

10.17.1 How to change the value of the Debug Level
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Figure 57.  Registry Editor dialog box

2.  Change to the following location: My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Telelogic\CM 
SYNERGY\Integrations\ccmdc

3.  Modify the registry key DebugLevel to your desired value (0, 1, or 2).

Use the following to help you determine which DebugLevel you would like to use.

 0 - No debugging support.  The log file will remain empty. (You may choose this 
DebugLevel to make the integration work faster) 

 1 - The log file will record all the errors, warnings, and exceptions.  The DebugLevel 
will initially be set to this value after installing the integration. 

 2 - The log file will record the function name, file name, input parameters, output, time 
stamp, errors, warnings, and exceptions. 

The integration will automatically generate error log files.  You may view the messages written to the 
error log files by viewing the files (ccmdc.log) generated in the following directories.

 C:\Documents and Settings\<username>\Application Data\Telelogic\vs300\ccmdc.log

 C:\Documents and Settings\<username>\Application Data\Telelogic\ccmdc70\ccmdc.log

or

 <Application Data path>\Telelogic\vs300\ccmdc.log

 <Application Data path>\Telelogic\ccmdc70\ccmdc.log

There are other error files that are generated by the integration.  These error files contain the last known 
error produced by the integration.  You may view the messages contained in these error files by viewing 
the files (ccmdc.err) in the following directories.

 C:\Documents and Settings\<username>\Application Data\Telelogic\vs300\ccmdc.err

10.17.2 How to view the Error Log
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 C:\Documents and Settings\<username>\Application Data\Telelogic\ccmdc70\ccmdc.err

or

 <Application Data path>\Telelogic\vs300\ccmdc.err

 <Application Data path>\Telelogic\ccmdc70\ccmdc.err
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The following is a list of known issues that exist in Telelogic Synergy for Microsoft Visual Studio Interface 
3.4.

 If you create a Solution project that has the same name as the Solution, your Telelogic Synergy 
database must be set to support multiple project instances.  To do this, start a Telelogic 
Synergy session by using the Telelogic Synergy Classic Client, make sure that ccm is in your path, 
and type the following commands in the command prompt: 1.)  ccm set role ccm_admin  2.)  
ccm query -t model -n base  3.)  ccm attr -m multiple_local_proj_instances -v TRUE @1

 Microsoft Visual Studio 2005 IDE may prompt you to: Save As, Discard, Ignore, or Overwrite, 
after a Solution/Project has been migrated.  Telelogic recommends that you respond to the 
prompt by selecting Overwrite. 

 Microsoft Visual Studio 2005 IDE may prompt you to Reload projects when project files are 
checked out.  Telelogic recommends that you respond to the prompt by selecting Reload.  

 The integration will display the Delete files prompt dialog box twice when performing the 
Exclude From Project or Delete operations on folders/directories that are controlled by 
Telelogic Synergy.  The integration will prompt you once for the folder/directory and once for the 
files located inside the folder/directory. 

 If you have more than one instance of Microsoft Visual Studio 2005 running, all of the instances 
will share the same Telelogic Synergy sessions and session data.  The possible problems that may 
occur are: 1.)  Changing the current task for a Telelogic Synergy session in one instance of Visual 
Studio will overwrite the current task for that same Telelogic Synergy session in another instance 
of Visual Studio.  2.)  If you migrate projects in one instance of Visual Studio, your migrated 
projects may be lost if other projects are migrated to Telelogic Synergy using another instance of 
Visual Studio.  The projects that are overwritten will belong to the instance of Visual Studio that 
exits the IDE first.  3.)  If you modify the integration settings in one instance of Visual Studio, 
your changes will be overwritten if the integration settings are modified in another instance of 
Visual Studio.  The integration settings that are overwritten will belong to the instance of Visual 
Studio that exits the IDE first. 

 You will not be allowed to migrate Solutions and Projects with the same name if the Visual Studio 
Solutions and Projects are created in the same location as your work area template. 

 When performing a Copy Project operation, your work area template must include project 
specific information that includes the project version and project instance.

 The integration will not allow the Undo Checkout operation to be performed on files that have 
been checked out as a result of a Rename operation. A warning message box will 
appear whenever an Undo Checkout operation is attempted on such files

 When performing any of the Telelogic Synergy team or taskbar operations by using a connection 
without a saved password, a Login dialog box will appear.  If you choose to Cancel the dialog 
box, the Login dialog box will not appear again; however, the integration may not be able to 
perform any operation properly.  You may invoke the Login dialog box again by selecting the 
Start Session menu option in the Telelogic Synergy Settings dialog box or restarting the 
Microsoft Visual Studio 2005 IDE. 

 If you want to modify the work area location of your Solution, you must perform the following 
steps:  1.) Exit the Microsoft Visual Studio IDE.  2.) Modify the work area location of your Solution 
by using Telelogic Synergy.  3.) Open the Solution from the new work area location and then 
proceed adding/migrating new Projects to your Solution.

 ASP.Net Web Application projects whose location in the file system is inside the directory of 
another Project or Solution directory can only be migrated to Telelogic Synergy as a Directory
when using the integration.

 Version control operations are supported by folders/directories; however, folders/directories will 
not display symbols and tooltips.

 In order to use the integration properly, the <Telelogic Synergy for Microsoft Visual Studio 2005 
Interface Install Directory> directory must be included in your PATH.
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Contacting IBM Rational Software Support

Support and information for Telelogic products is currently being transitioned from 
the Telelogic Support site to the IBM Rational Software Support site. During this 
transition phase, your product support location depends on your customer history.

Product support

 If you are a heritage customer, meaning you were a Telelogic customer 
prior to November 1, 2008, please visit the Synergy Support Web site. 
(https://support.telelogic.com/synergy)

 If you are a heritage customer, meaning you were a Telelogic customer 
prior to November 1, 2008, please visit the Change Support Web site. 
(https://support.telelogic.com/change)

    Telelogic customers will be redirected automatically to the IBM Rational Software Support 
site after the product information has been migrated.

 If you are a new IBM Rational customer, meaning you did not have Telelogic-licensed 
products prior to November 1, 2008, please visit the IBM Rational Software Web site. 
(http://www.ibm.com/software/rational/support/)

Before you contact IBM Rational Software Support, gather the background information that 
you will need to describe your problem. When describing a problem to an IBM software 
support specialist, be as specific as possible and include all relevant background 
information so that the specialist can help you solve the problem efficiently. To save time, 
know the answers to these questions:

 What software versions were you running when the problem occurred? 

 Do you have logs, traces, or messages that are related to the problem? 

 Can you reproduce the problem? If so, what steps do you take to reproduce it?  

  Is there a workaround for the problem? If so, be prepared to describe the 
workaround. 

Other information
For Rational software product news, events, and other information, visit the IBM 
Rational Software Web site. (http://www.ibm.com/software/rational/support/)
 

Note When sending an error report through e-mail, please be sure to include the following:

 all log files (click on How to view the Error Log (Section 10.17.2) for location of the 
log files)

 screen shot of the error in question
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Appendix
Notices

This information was developed for products and services offered in 
the U.S.A. IBM may not offer the products, services, or features 
discussed in this document in other countries. Consult your local 
IBM representative for information on the products and services 
currently available in your area. Any reference to an IBM product, 
program, or service is not intended to state or imply that only that 
IBM product, program, or service may be used. Any functionally 
equivalent product, program, or service that does not infringe any 
IBM intellectual property right may be used instead. However, it is 
the user's responsibility to evaluate and verify the operation of any 
non-IBM product, program, or service.
IBM may have patents or pending patent applications covering 
subject matter described in this document. The furnishing of this 
document does not grant you any license to these patents. You can 
send written license inquiries to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte character set (DBCS) 
information, contact the IBM Intellectual Property Department in 
your country or send written inquiries to:
IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan
The following paragraph does not apply to the United Kingdom 
or any other country where such provisions are inconsistent 
with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION 
PROVIDES THIS PUBLICATION “AS IS? WITHOUT WARRANTY 
OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow disclaimer of 
express or implied warranties in certain transactions. Therefore, this 
statement may not apply to you.
This information could include technical inaccuracies or 
typographical errors. Changes are periodically made to the 
information herein; these changes will be incorporated in new 
editions of the publication. IBM may make improvements and/or 
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changes in the product(s) and/or the program(s) described in this 
publication at any time without notice.
Any references in this information to non-IBM Web sites are 
provided for convenience only and do not in any manner serve as 
an endorsement of those Web sites. The materials at those Web 
sites are not part of the materials for this IBM product and use of 
those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any 
way it believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for 
the purpose of enabling: (i) the exchange of information between 
independently created programs and other programs (including this 
one) and (ii) the mutual use of the information which has been 
exchanged, should contact:
Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street Cambridge,
Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms 
and conditions, including in some cases, payment of a fee.
The licensed program described in this document and all licensed 
material available for it are provided by IBM under terms of the IBM 
Customer Agreement, IBM International Program License 
Agreement or any equivalent agreement between us.
Any performance data contained herein was determined in a 
controlled environment. Therefore, the results obtained in other 
operating environments may vary significantly. Some 
measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be 
the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. 
Actual results may vary. Users of this document should verify the 
applicable data for their specific environment.
Information concerning non-IBM products was obtained from the 
suppliers of those products, their published announcements or 
other publicly available sources. IBM has not tested those products 
and cannot confirm the accuracy of performance, compatibility or 
any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in 
daily business operations. To illustrate them as completely as 
possible, the examples include the names of individuals, 
companies, brands, and products. All of these names are fictitious 
and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental.
If you are viewing this information softcopy, the photographs and 
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color illustrations may not appear.

Trademarks

IBM, the IBM logo, ibm.com, Telelogic, Telelogic Synergy, and 
Telelogic Change are trademarks or registered trademarks of 
International Business Machines Corporation in the United States, 
other countries, or both. These and other IBM trademarked terms 
are marked on their first occurrence in this information with the 
appropriate symbol (® or ™), indicating US registered or common 
law trademarks owned by IBM at the time this information was 
published. Such trademarks may also be registered or common law 
trademarks in other countries. A current list of IBM trademarks is 
available on the Web at www.ibm.com/legal/copytrade.html 
(http://www.ibm.com/legal/copytrade.html).
Microsoft and Visual Studio are either trademarks or registered 
trademarks of Microsoft Corporation.
Other company, product or service names mentioned may be 
trademarks or service marks of others.
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